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Stem-and-Leaf Diagrams Using Dates on Coins

One way of organizing data is to make a stem-and-leaf display. Here’s an example. Have students
take one or two pennies (or coin of your choice) out of their pockets and look at the dates.
Record the dates on the board. For example, looking at the change in my pockets today | find
these dates on coins:

1967 1990 1992 1989 1982 1989 1972 1998 1978 1993 1982

1992 1989 1995 1995 1996 1994 1993 1983 1998 1987

We can organize the data showing the various decades or class intervals (the “stems”), with just the
last digit (the “leaves™) of the year on the right side. After that you can write the frequency to
make other kinds of graphs.

Stem | Leaf Frequency
196 |7 1
197 |28 2
198 (9292937 7
199 (02832556438 |11

|
If we wanted smaller class intervals, say of 5 years, we could write the years ending in 0-4 with a
stem ending in, say, = and the years ending in 5-9 with a stem ending in =:

]
Stem | Leaf Frequency

196a | 7

197= | 2

1970 | 8

198= (223
198a (9997
199= 1023243
1990 {85568

glo|ld]|lw]|r |+~ |-

One nice thing about stem-and-leaf displays is that they look like text versions of histograms.
Another advantage is that they preserve values of the original data, unlike making tally marks.



Using Lines to Make Predictions

Percent of World’s Population That Is Urban, 1950-95

Year

1950 |[1955 |[1960 |[1965 |1970 |1975 |1980 |1985 |1990 | 1995*

Share% [ 29.3 |31.4 [34.2 |[355 |36.6 [37.7 [39.4 |41.2 |43.1 |45.2

*preliminary estimate Source: NEA graphic, Johnson City Press, July 21, 1996

Use the urban-world-population data in the table to plot the points on a graph. Note: The
relationship appears to be roughly linear.

Use your piece of uncooked spaghetti to find what appears to be the best-fit line that goes
through or near the most points.

Find two points on the line and compute the slope of the line. For calculation purposes, you
may wish to use a baseline year of 0 rather than 1950. Then 1960 would be 10, and so on.
If so, remember to take this adjustment into consideration when answering questions 4-7.

Use the slope and a point to write the equation of your line. Write the equation in slope-
intercept form.

Check how well your model fits the data by “predicting” the urban percent in those years that
you did not use in questions 2 and 3.

Use your equation to predict the percent of world population that will be urban in the years
2000 and 2005.

If your model continues to be accurate, in approximately what year will the world's population
be 50 percent urban?

Is it reasonable to use your model to estimate a time when no population was urban (0%) or
when the entire population (100%) will be urban? Explain your answer.



Answer Key to Urban Population Worksheet:

1-2. Answers will vary; see example at right

(generated by a Quattro Pro spreadsheet). Urban % of World Population

3. Answers will vary. As an example, using the 150-95

points (1950,29.3) and (1990,43.1) give a slope 50

of 0.345. c 45

4. Answers will vary. The equation of the %40 3
regression line using a statistical calculator is £ —
approximately y = .33x + 29.92 (using O for %35 .

1950). Using the points (25,37.7) and (40,43.1) & 30 3

gives an equation of y =.36x + 28.7. 2
5. Answers will vary.

6. Using the regression line derived from a
statistical calculator, the population in 2000

could be 46.42% urban and in 2005 could be
48.07%. Using the sample equation in #4 yields 46.7% and 48.5%, respectively.

7. Again from the calculated regression line, the world’s population may be 50% urban in 2010.
8. No. This model only applies well to the latter half of the 20th century. The regression line
“predicts” 0% urban population in 1860 or thereabouts, but we know there were cities then.
Likewise, it is unreasonable to assume that everyone will live in cities in the future, since farmers will
always be needed, even in 2160.

1950 1960 1970 1980 1990 2000
Year

Setup for a spreadsheet:

Put the information in a spreadsheet. Quattro Pro can make a scatter diagram if you highlight the
information and tell it to make a broken line graph. When you’ve created the graph, edit it. Right
click on the line and choose Line Series from the box that pops up. On the Line Settings tab, choose
the rectangle with no line on it. You can draw in your own line with the tool on the bar that looks
like a diagonal line. Just click the square, then click where you want the line to start, keep holding
the button down, move the mouse where you want the line to end, and release the mouse button.
By right clicking on that line you can change its properties as well. (That’s how the graph on this page
was constructed.)

This activity, in a slightly different form, was one | wrote that appears in Mathematics Teacher,
September, 1997, in the “Media Clips” column.



Scatter Plots: Absences and Grades

Below are the number of absences and final semester grades from part of an intermediate algebra class
a few years ago. The class met 28 times on Tuesdays and Thursdays. A grade below 70 was
considered failing.

Absences 2 2 8 0 2 15 3 2 18 2 1 1

Grade 70 84| 64| 100 78 9 91| 72 8 78 99| 87

Make a scatter diagram showing this information.

1. Draw what appears to be the best fitting line through the points.

2. Pick two points on your line. (They don’t have to be points you plotted.) Find the slope of
the line. Write it first as a fraction and then as a decimal rounded to the nearest hundredth.
Now use the slope you computed and use the point-slope form to get an equation for this line.
Find the x- and y-intercepts for this equation. What do they mean?

What kind of relationship does there appear to be between absences and grades?

What does the slope represent in this case?

Use your equation to predict the grade for a person with 5 absences. Do you think this is a
good prediction? Why or why not?

No os~w

Comments

From a statistical calculator, the regression line equation is y = 93.24 — 4.98x. The correlation
coefficient was computed to be about -0.95.

Using this equation, a person with five absences would have a predicted grade of about 68.

Chart generated in Quattro Pro:

Absences and Grades
Intermediate Algebra

100
80
60
40
20

aif| |

Course Grade

0 5 10 15 20
Number of Absences

Original idea came from Jim A. Ham’s home page at Delta College in Michigan, found at
<http://www.delta.edu/~jaham/absence.txt>. | used information from my own classes and different
questions. Ham has a number of interesting ideas and links, including several more activities
blending algebra and statistics, on his home page at <http://www.delta.edu/~jaham>; you might want
to check it out!



Edible Data

Objective: At the conclusion of this activity, the student should be able to construct bar graphs
and circle graphs (pie charts).

Materials/Additional sources:

For each group of approximately four students, a small bag of M&Ms, Gummi Bears, jelly
beans, Reese's pieces, or any other snack-type food that comes with several different colors in
each bag (but not too many, as it slows the process down).

(optional) napkins, paper towels, pie pans, margarine containers, or other item to help keep
the candy from rolling off in the floor and make counting easier

Protractors (supplied by teacher or student, at teacher's discretion), at least one per group
Straightedges

Calculators, at least one per group (usually supplied by students)

(optional) Sheets with circles already drawn with the center marked. The instructor may even
wish to have circles with sectors already marked off in increments of 5° or 10°.

(optional) Computers with graphing software and printer and/or floppy disks

(optional) Colored markers, pencils, or crayons. It's interesting that college students, when
given a chance, may want to color their graphs, especially if it's at a stressful time of the
semester!

Activities

Have students work in groups of approximately four. Give each group a small package of M&M:s,
Reese's pieces, Fun Fruits, or other type of multicolored candy. You may also want to give each group
something to place the candy pieces on or in (such as a margarine container) if the desks are tilted.
You may need to guide the students through the process step by step as they go along, depending on
their backgrounds.

Instructions for each group:

Before opening the package, the group should predict how many pieces are in the package and how
many of each color might be found when opened. Then open the package and sort the pieces by
color or other appropriate category. Do not eat the data yet!

Record the number of pieces of each category that are in the bag in a frequency table. Be
sure to note the total number of pieces.

Make a bar graph to represent this information.

Compute the percentage of the total each color represents, and then translate that into
degrees of a circle. Use this information to construct a circle graph.



Consolidate information from all groups and record this on the board/overhead. See how closely
each groups' findings match the aggregate.

Discussion questions to consider: Which color appeared most frequently? least frequently? Is this true
overall, or just in some packages? If you opened another package, what distribution of colors would
you expect?

Save the information collected to use again later in discussing mean, median, mode, and probability.
Then (and only then) may the students eat their data! Continue with the lessons for the rest of this
objective.

Extension: In the lesson on measures of central tendency and variability, use the aggregate data
collected in this activity to compute the mean, median, mode, and standard deviation of the
frequencies of the various categories.

Interesting Tidbits: Here are the official percentages of M&Ms in each kind of bag as given by
M&M/Mars Consumer Affairs. (Source: Chance, vol. 9, no. 4, 1996, p. 22)

Variety Brown | Yellow | Red Orang | Gree [ Blue |Pink | White | Purple
e n

Plain 30% 20% 20% | 10% 10% | 10%

Peanut 20% 20% 20% | 10% 10% | 20%

Almond 20% 20% 20% 20% | 20%

Peanut Butter | 20% 20% 20% 20% | 20%

Easter 20% 20% | 20% | 20% 20%
Valentine’s 40% 40% | 20%

Note: The Easter colors are pastels, so they’re not the same as the regular colors.



More Ideas for Statistical Activities

Reaction Times

Materials: Meter sticks or yardsticks, calculators (likely student supplied). Optional: Computer with
statistical package or spreadsheet.

Activity: Have students work in pairs or threes. One student holds a meter stick vertically (with low
end of the measuring scale at the bottom) right above the other student’s hand. On cue, the student
drops the meter stick (or yardstick) and the other student grips it as soon as possible. Record the
number of centimeters (or inches) it took for the student to catch the meter stick (yardstick). Students
switch jobs and repeat the procedure. Have each student get several trials and record each trial. Then
consolidate the information for the class as a whole.

Have students compute the mean, median, mode, and range, first for themselves, then for their pair
or group, then for the class as a whole. Discuss what might be an appropriate type of graph for this
activity. Try constructing graphs on graph paper or spreadsheets. You might even introduce the
concept of standard deviation here, perhaps showing how to use the statistical functions of the
calculator or spreadsheet (Quattro Pro uses @5TD( r ange) , for example).

How Do Your Feet Measure Up to Your Height?

Here’s another one for making scatter plots. If you wanted to get really brave, you could introduce
a correlation coefficient to see how closely height and shoe size are related.

Have each student relate his/her height and shoe size. The height may be done in inches or converted
to centimeters. Alternatively, heights could actually be measured in centimeters in class, and it might
be interesting to find the lengths of students’ feet in centimeters. In case someone has feet of
significantly different size, take the mean of the two sizes. Optionally, students may want to plot shoe
size versus height on graph paper. Note: It is probably a good idea to have separate graphs for men
and women, since their sizes are computed slightly differently.

After making a scatter diagram, have the students predict, for example, the height of a woman who
wears a size 5 shoe.

For a dramatic flair, make up a story about footprints being found in the mud or snow. Detectives
have determined the size of the shoe. What was the probable height of the suspect?



Making Graphs with Quattro Pro

(Note: These instructions are for Quattro Pro v. 7, included with the Word Perfect 7 Suite. They have also been
tested for Version 6. | haven’t bought Version 8 yet, so I can’t promise they’ll work exactly the same. Similar
instructions should hold for other spreadsheet programs with graphing capabilities.)

First, enter the information you want into a spreadsheet. For the example with the coins, here’s a
table we might enter:
Now use the mouse to highlight this part of

A B the spreadsheet. (Bring the mouse to one
1 Decade |Frequency corner of the spreadsheet, press the left button
2 1960s 1 down and hold, move it to the opposite
3 1970s 2 corner, and release. The boxes should appear
4 1980s 7 in inverse video.)
5 1990s 11

From the Graphics menu at the top, choose New Chart. ... A new pane pops up.

Help

Series | Type | Tites | Name| Bar Graphs
Kbt AA2 A5 Cancl | To make a bar graph, everything
Legend:|AB1.51 | should be fine on the Series tab, but

here’s a note on the settings. The X-
Axis refers to the x-axis if you're doing
a line or bar graph, or the categories

o
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i used for a circle graph. The Legend
5t | refers to what will be seen as a label on
| the x-axis. Then 1st is your y-axis. If

you do want to change the cells used
for creating your graph, you can either
manually type in the addresses of the
Dl cells (note: the A: means the top layer
of the spreadsheet), or you can click on
the arrow in the box to the right and
highlight the cells you want to use and
press Enter.

[" Beverse Series

™ Fow/Colurmn Swap

Now you’ll want to choose the type of graph you want. Click on the Type tab in this pane.
You'll get a pull-down menu at the top to choose Area/Line, Bar, Stacked Bar, Pie, Specialty, or Text.
Let’s start with a simple bar graph, which would be appropriate for our data. Click on the down-arrow
and choose Bar. You'll see several styles of bar graphs to choose from. Let’s choose the first one on



the first row ( |H ) for now for a traditional vertical bar graph.

Now we’ll set up our titles and labels. Click on the tab marked “Titles.” The Main Title is
the large title you want above the entire graph. The Subtitle is just underneath. Then you can choose
titles (labels) for your X-axis and the y-axis, which here is the Y1-axis. (The Y2 axis isn’t needed here.
We can type in a main title of something like “Dates on Change.” Our X-axis could be labeled
“Decades” and the Y-axis “Frequencies.”

The Name tab allows you to name the graph you're creating. Once you've named it, it appears
under the Window menu at the top of the screen when you pull it down.

Once all of that is done, click on OK. Now you have your first graph! It should look
something like this:

But how can you print it? One of the things

you’ll probably want to do is to import your

Dates on Change graph into a word processing document. For

12 example, | sometimes create a graph that | put
10 in a test and ask questions about.

Click on the boxed X on the second (usually
gray) line at the top right corner of the screen.
Now go to the Graphics menu on the top of
II the screen, and choose Insert Chart.... Select
1960s  1970s  1980s  1990s the chart you just created. Your mouse cursor
Decades will change to an icon that looks like a graph.

I Frequency Click in an empty area of the spreadsheet.

While there are still the little black squares at
the corners of the image, either press Control-
C, click on the copy icon at the top, or choose

Frequencies

o N A O

Copy from the Edit menu. Then switch to your word processing program (e.g. Word Perfect), and
press Control-V, select Paste from the Edit menu, or click on the Paste icon. You may have to move
your mouse pointer over the chart, right-click, choose Position, and choose to anchor the graphic to
the paragraph or a character, then move it where you want it. Otherwise it often gets stuck
somewhere on a page where you didn’t intend to put it.

You may be saying, “This is great, but even if my printer can print in color, my copier doesn’t!”
In Quattro Pro you can change the colors of the bars. Go back to the spreadsheet. Under the
Graphics menu, choose Edit Chart. . .. Choose the graph you just made. Now right-click your mouse
over one of the bars and choose Bar Series Properties... from the pop-up menu. Click on the tab
marked Fill Settings. Click on the box marked Pattern Color and click on the black or one of the gray
squares. If you don’t want a solid bar, you can pick a pattern for the bars instead by clicking on one
of the boxes underneath. (By the way, to make a histogram, you can go to another tab marked Bar
Options and change the Bar Width Percentage to 100% by sliding the slider or clicking on the
numbers and deleting and changing them.) Play around with the other settings and see what they do.
Click on OK when you’re done and paste it onto the spreadsheet as before. Here’s an example of our



graph being changed, in reduced form: Dates on Change

[
)

=

Frequencies

o N & o ®» O

1960s 1970s 1980s 1990s
Decades

[ Frequency
Circle (Pie) Graphs

Now let’s make a circle graph. Here’s a different spreadsheet showing how many hours of television
100 students in some classes last spring claimed they watched on average each week:

A B
1 Hours People Note: To get “0-9" (and other similar classes)
2 0-9 5 instead of the value zero minus nine, begin the
3 10-19 53 cell with a double quotation mark: "0-9. It
4 20-29 26 won’t appear on the spreadsheet, but it forces
5 30-39 13 the spreadsheet to treat “0-9" as a label rather
6 >40 3 than subtraction.

Again we’ll highlight this information, go to Graphics, choose New Chart..., and on the Type tab,
choose Pie from the pull-down menu. We can get some fancy ones, but this one will be plain. Go
through the same approximate steps as outlined above to make a bar graph. To get something we can
photocopy, you can click on the pull-down bar marked “Default¥” and select “Black and White
Patterns.” If you don’t like the patterns the computer chooses, you can right-click on any segment,
choose Pie Chart Properties, and click on a different pattern, finishing by clicking OK. | haven’t
figured out how to change the percentages to be formatted any way except in hundredths. You can
change any of the fonts by pulling down on the font menu while you’re viewing the chart. Here’s our
result:

Weekly TV Hours Watched

-9 (5.00%)

10-19 (53.00%)

10



